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STAAD.Pro V8i Release Report 
Introduction 
 
The Software Release Report for STAAD.Pro V8i contains detailed information on 
additions and changes that have been implemented since the release of STAAD.Pro 2007 
build 03.  This document should be read in conjunction with all other STAAD.Pro 
manuals, including the Revision History document. 
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AD.V8i.0 New Features Affecting the General Program 

 
This section describes features that have been added that affect the general behavior of 
the STAAD.Pro application.  
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AD.V8i.0.1 ProjectWise Integration 

Purpose 
ProjectWise is an engineering project team collaboration system which is used to help 
teams improve quality, reduce rework, and meet project deadlines.  One of the major 
pieces of functionality provided by ProjectWise is an Integration Server which allows 
data to be managed and shared across a distributed enterprise. 
STAAD.Pro has been enhanced so that the model STD data file can be managed on a 
ProjectWise server. 
 

Description 
Four integration functionalities have been added. These are 
 

• Open a STAAD model from a ProjectWise repository. 
• Save a local STAAD model into a ProjectWise repository. 
• Update an existing model from ProjectWise. 
• Review model properties (meta-data) which has been opened from a 

ProjectWise repository. 
  
Note that access to all of these functionalities is available from ProjectWise sub-menu 
under the general File menu described below.  
 

ProjectWise repository 
Installation and management of a ProjectWise server is beyond the scope of this 
document and should be obtained from the ProjectWise installation. 
 

ProjectWise client 
A local ProjectWise client should be installed which allows access to ProjectWise 
repositories. 

 
 

STAAD.Pro 
When STAAD.Pro is launched, the option to open and check out a STAAD.Pro STD file 
from a ProjectWise repository is made available from the Project Tasks on the Start Page 
thus:-  
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This is also available from the File menu while still on the Start Page prior to opening a 
model:- 
 

  
 
If a suitable ProjectWise client is not installed, then the link on the Start Page is shown as 
unavailable with a red line through the icon thus:- 

 
 

Login 
As authentication is required to access files stored on a ProjectWise repository, a login 
dialog allows the required details to be entered either with specific user credentials or by 
using the current windows login credentials thus:- 
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Files that are accessed from a ProjectWise server are ‘Checked Out’ and stored locally 
during the STAAD.Pro session until the file is closed and then it is returned to the server. 
 

Opening a STAAD Model from a ProjectWise repository 
The first time that a successful link to a ProjectWise server is established, a location in 
which check out files are to be stored locally and additionally, where all the auxiliary data 
files are stored whist STAAD is running is required.  Afterwards and on all future 
occasions, the ProjectWise open dialog presented is then presented where the repository 
can be navigated and filtered as defined in the ProjectWise documentation.  
 

 
 
Note the significance of the icons next to the STAD filenames.  These indicate the status 
of the file such as the current document, checked out to you, or locked as checked out to 
some other user.  Refer to the ProjectWise documentation for a full description of each 
icon. 
 
With a file checked out and loaded in STAAD.Pro, it is possible to see the ProjectWise 
Properties, by selecting the option from the ProjectWise toolbar or File menu:- 
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Saving a New model onto the Server 
If working on a STAAD model that has not originated from a ProjectWise server (e.g. 
starting a new file) and it has been decided that it needs to be added to a repository, then 
at any time whilst working in the STAAD.Pro environment, clicking on the toolbar 
option Add to ProjectWise server, or equivalent File>ProjectWise menu option will 
launch the following dialog:- 
 

 
 
 
Selecting the option No Wizard offers the following dialog into which the file details can 
be entered. 
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Clicking on Save, adds this model to the repository, but indicates its status as checked out 
until the file is closed in STAAD.Pro and the model checked back in. 
 
Alternatively, by selecting the Advanced Wizard option the data needed to define the 
ProjectWise data file is presented in the following four steps:- 
 
Advanced Wizard 

 
 
Select target Folder:- 
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Document Properties:- 

 
 
Create the document:- 
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Creates the document and marks it as checked out until the file is closed and checked in 
to the server. 
 

Saving changes of a Checked Out model Back on the Server  
When a model is checked out from a ProjectWise server, selecting Save or Save As, only 
maintains a local copy of the model.  There are two methods available to update a 
checked out model.  Firstly, during a STAAD.Pro session, it is possible at any time to 
save any changes back on the server by selecting the Update Server Copy icon from the 
ProjectWise toolbar or from the File>ProjectWise menu.   
 
First save updates to the file locally.  If not, then this will be prompted. Then the 
following dialog is displayed which allows a comment to be added to this model, thus:-  
 

 
 
The file remains checked out and can be continued to be worked on. 
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The second method is automatically generated when a checked out model is closed.  This 
launches the Check In dialog that displays the file(s) that are to be checked in and 
provides four actions:- 
 

 
 
 
Check In.   

This copies the local version of the STAAD model back to the server and releases it 
so that it is available for others to modify.  If the option Create New Version is 
selected, then a new copy of the file is created on the server which becomes the 
current version of the model.  The status of the checked out model is changed to 
read only on the server and can be used as a reference to a stage in the development 
of the model. 

 
Update Server Copy. 

This updates the model on the server with the current local model, but does not 
change its status which remains as checked out. 

 
Free 

This changes the status of the model as checked in which allows other users to take 
control and check out the model, but does not update the server model.  Thus local 
changes will be discarded  

 
Cancel 

This cancels any change to the status of the model or the model itself on the server.  
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Menu 
The commands that drive the ProjectWise integration are defined in the main File menu 
thus:- 
 

File>ProjectWise> 

 
 
The Add... command is available when using a locally opened (not checked out from 
ProjectWise), which allows the current model to be saved into a ProjectWise repository. 
 
The Open… command is available when a suitable ProjectWise client has been installed 
to allow access to a repository from which to check out a STD file. 
 
The Update Server Copy command is available when working on a checked out file and 
the changes made on the model can be  
 
 

Toolbar 
A new toolbar named ProjectWise has been added that duplicates the commands from the 
File>ProjectWise menu, thus:- 

 
 
Notes:- 

1) For more details on ProjectWise refer to the ProjectWise client installation 
documentation 

2) This functionality requires access to a version V8i or greater of ProjectWise. 
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AD.V8i.0.2 CIS/2 Update 

Purpose 
The STAAD.Pro tool to import and export models with the CIS/2 translator has been 
enhanced to work with international models and transferring models into 3D modeling 
such as SmartPlant 3D. 
 

Description 
The CIS/2 (CimSteel Integration Standard, Version 2) allows for the transfer of steel 
models using a prescribed data standard in the STEP (Part 21) format.  These files can 
contain different models including analysis models.  The STAAD.Pro CIS/2 translator 
only operates on the analysis model within the file.  Whilst STAAD.Pro has supported a 
wide range of the steel sections that this standard can support, this enhancement allows a 
far greater range of sections to be imported/exported with this tool. 
 
IMPORT 
The CIS/2 import can be initiated after starting a new model and before creating any 
model data, selecting the menu option,  File>Import… 

 
 
Selecting the CIS/2 option and clicking on the ‘Import’ button allows selection of a 
suitable STEP file.  This file is a text file and will be similar to the following extract:-   
 

ISO-10303-21; 
HEADER; 
/* Generated by software containing ST-Developer 
 * from STEP Tools, Inc. (www.steptools.com)  
 */ 
FILE_DESCRIPTION( 
/* description */ ('CIS2 Export File'), 
/* implementation_level */ '2;1'); 
FILE_NAME( 
/* name */ 'model', 
/* time_stamp */ '2007-01-08T17:00:33+00:00', 
/* author */ (''), 
/* organization */ (''), 
/* preprocessor_version */ 'ST-DEVELOPER v9', 
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/* originating_system */ 'STAAD.Pro 2007', 
/* authorisation */ ''); 
FILE_SCHEMA (('STRUCTURAL_FRAME_SCHEMA')); 
ENDSEC; 
DATA; 
#10=LOAD_COMBINATION_OCCURRENCE(1.39999997615814,#13,#264); 
#11=LOAD_COMBINATION_OCCURRENCE(1.39999997615814,#13,#265); 
#12=LOAD_COMBINATION_OCCURRENCE(1.60000002384186,#13,#266); 
#13=LOADING_COMBINATION('ULS',$,#2511); 
#14=LOAD_ELEMENT_DISTRIBUTED_CURVE_LINE(#265,'Member19UDLLoad1',$
,#1089, 
$,$,.F.,.GLOBAL_LOAD.,.TRUE_LENGTH.,#214,#214,#64); 
#15=LOAD_ELEMENT_DISTRIBUTED_CURVE_LINE(#265,'Member20UDLLoad1',$
,#1090, 

 
Once a file has been selected, the data is ready to be imported with the CIS/2 import tool 
thus:- 

 
 
Clicking the Import button then runs the model import where the CIS/2 file is processed 
and the analysis model data is extracted to form the STAAD.Pro model.  
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Note that as the CIS/2 file is being processed, a log file which identifies the data that has 
been utilized in the STAAD model is produced and displayed which can be saved as a 
text file for future reference. 
 
EXPORT 
The CIS/2 Export is available for any model that has been created as an option in the 
menu item File>Export… 

 
 

Selecting the CIS/2 option and clicking on the ‘Export’ button allows the definition of a 
suitable STEP filename and folder to locate it.  Once again the CIS/2 tool is presented, 
this time with an Export Model button at the bottom which when clicked creates the STP 
file. 
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Once again, when the export has completed, the user can save the log file which is 
produced as the model is converted into the STEP format. 

  
 
 
Enhancements 
The STAAD.Pro CIS/2 import now recognizes sections defined from standard databases 
such as those defined in Japanese, British, Indian, Australian and European tables. 
 
The import/export has been enhanced to support the ability of STAAD.Pro to create 
double sections, such as back to back angles and channels or double wide flange sections.  
Additionally, it now supports the creation of T sections which are defined in STAAD.Pro 
as a wide flange section that is split at mid height. 
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Although CIS/2 has been developed for the processing of steel models, the STAAD.Pro 
translator will now support the transfer of prismatic properties normally associated with 
concrete sections.  This means that sections defined as PRISMATIC in a STAAD.Pro 
model will be included in exported STP file and can be imported if they exist.  
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AD.V8i.1  Features Affecting the Pre-Processor 
(Modeling Mode) 
 

 
Several new features have been added and existing features have been modified in the 
pre-processor section of the program, also known as the Modeling Mode. These are 
explained in the following pages. 
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AD.V8i.1.1 ASME NF Steel Design Codes 

Purpose 
The design of steel sections according to the requirements in the American Society of 
Mechanical Engineers (ASME) specifications, Rules for the Construction of Nuclear 
Power Plant Components, Section III – Subsection NF has been implemented and the 
steel design page has been updated to allow the design parameters to be defined and 
assigned. 
The design requirements for the following years have been added:- 
   1974 

1977 
1989 
1998 

 

Description 
Post analysis steel design code checking requirements for the required ASME NF code 
can be selected by entering the Design>Steel page and setting the ASME code / year in 
the Current Code option in the Steel Design dialog:- 
 

 
 
The method for selecting design parameters and assigning them to the members to 
change them from the default values is exactly the same as for all other steel design 
codes.  Additionally, choosing members that are to be checked or selected for maximum 
utilization follows exactly the same method as for all other steel design codes.   
 
For more information on the technical requirements of this design code, including the full 
set of parameters and default values, see the new section in the International Design 
Codes manual on the ASME NF design codes.  
 
 
Notes 

1) In order to run a design check to any of the ASME NF design codes, then access 
to a STAAD Nuclear Code pack will be required. 
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AD.V8i.1.2 Floor Response Spectrum 

Purpose 
A new dynamic feature has been added that allows the extraction of a response spectrum 
from a collection of nodes that constitute a floor when subjected to a time history loading.  
This information can then be used in conjunction with equipment that will be supported 
by these floors and is often required by the equipment manufacturers.  
 
Note : 
This feature requires access to an Advanced Analysis license 

Description 
The required commands (see section AD.V8i.2.3 Floor Response Spectrum for more 
information) can be entered graphically after adding the analysis command by selecting 
the new analysis sheet ‘Generate Floor Spectrum’ thus:- 
 

 
 
This command should follow immediately the definition of the analysis and will require 
defined groups of nodes which need to be defined first. 
 
The following displays the layout of this sheet:- 
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Note that the each line of settings constitutes one floor which can have one or more floor 
groups assigned.  The resulting response spectra will be based on the collective responses 
of all the nodes in the selected groups. 
 
Once the required options have been set, click on the Add button to add the command set 
to the model which should appear in the Analysis Window thus:- 
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Once the command has been added and the file saved, the analysis can be run which will 
generate a new sub-page in the Post-Processing Mode in the Dynamics Page called Floor 
Spectrum:- 
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Entering this page, STAAD.Pro will display the floor spectrum thus:- 
 

 
 
To change graphs to that of another selection of node groups or damping ratio, then select 
the required set from the drop list in the Response Spectrum Table. 
 
The graph is initially set to display the results on a log/log graph.  This can be changed to 
a linear graph by right clicking on the graph and selecting the ‘Linear Graph’ option.  
Additionally, the calculated points on the graph can be added by again right clicking on 
the graph and selecting the option ‘Show Points’. 
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The data that has defined the graph can also be exported to a text file and used in a third 
party application by right clicking on the graph and selecting the option ‘Save Data in 
Text File…’ 
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AD.V8i.1.3 Russian Wind Loading 

Purpose 
The wind loading as defined in the design code SNiP 2.01.07–85 “Loads and Actions” 
added in this version of STAAD.Pro can be added graphically to the model by 
modifications in the Loads Page.  
 

Description 
There are two areas where the graphical user interface has been updated:- 
 

a) Wind Load Definition 
The dialog has been updated to allow the entry of the required parameters for a Russian 
Wind Load definition thus:- 
 

 
 
This will create a definition which can be added to a wind load case. 
 
 

b) Wind Load command 
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Note that the first load case which has a Russian Wind Load command added to it will 
consider all other loads defined in it as the masses to be considered for calculating the 
dynamic effect which is required by this command. 
 
For technical details of this wind loading see section AD.V8i.2.2. 
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AD V8i.1.4 Additional Standard Profile Databases   

Purpose 
An additional Australian cold formed database has been provided to complement the cold 
formed sections databases currently provided. 

Description 
The following database and tables have been added from OneSteel.  Duragal®, Galtube® 
and Tubeline® 
 
Australian Cold Formed Steel Hollow Sections 
 
Circular Hollow Sections:- 

Galtube Plus®, 26.9mm to 76.1mm diameter 
Tubeline, grades C250L0 (AS1163) and 350L0 (AS1163), 21.3mm to 457.0mm 

 
Rectangular Hollow Sections 

Duragal®, grade C450L0 (AS1163), 50x20mm to 150x50mm 
Galtube Plus®, grade C350L0, 50x20mm to 75x25mm 
Tubeline®, grade C350L0 (AS1163), 50x20mm to 250x150mm    

 
Square Hollow Sections 

Duragal®, grade C450L0 (AS1163), 20x20mm to 100x100mm 
Galtube Plus®, grade C350L0, 20x20mm to 65x65mm 
Tubeline®, grade C350L0 (AS1163), 13x13mm to 250x250mm    
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AD.V8i.2  Features Affecting the Analysis and Design 
Engine 
 

 
The following section describes the new features have been added to the analysis and 
design engine and existing features that have been updated or modified. 
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 AD.V8i.2.1 ASME NF 

Purpose  
The design of steel sections according to the requirements in the American Society of 
Mechanical Engineers (ASME) specifications, Rules for the Construction of Nuclear 
Power Plant Components, Section III – Subsection NF has been implemented and the 
steel design page has been updated to allow the design parameters to be defined and 
assigned. 
The design requirements for the following years have been added:- 
   1974 

1977 
1989 
1998 

 

Description 

For the list of parameters and commands including the default values, please refer to the 
International Design Codes manual, section… 

For each steel member that is checked, the following checks are performed according to 
the clauses for that year:-  
  1. Slenderness check  
  2. Tension  
  3. Compression 
  4. Bending (a) About major axis, (b) About major axis 
  5. Shear 
  6. Combined Stresses 
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AD.V8i.2.2 Russian Wind Loading 

Purpose  

The wind loading commands have been enhanced to allow the creation of wind loading 
as defined in the in Russia by the design code SNiP 2.01.07–85 “Loads and Actions”.  

The basic quantity in the wind loading is the characteristic (normative in Russian 
terminology) wind pressure. The reference wind velocity pressure corresponds to a 10-
minute time-averaged velocity pressure at 10-metres height in a flat terrain, based on a 5-
year return period. This wind pressure is the static component of the wind load. The total 
wind pressure consists of static and fluctuating components. If the structure is sufficiently 
flexible, according to the code provisions, the dynamic structural response to the 
fluctuating wind component must be taken into account. 

The updated wind loading commands automatically perform both the aerodynamic and 
structural load analysis of vibration-susceptible buildings and structures. 

Description 

The wind loading commands have been updated to support the wind loading as defined in 
the Russian design code.  This requires the creation of the following commands. 

General Format: 

There are three parts to creating a Russian wind load on a STAAD Model 

a) Definition of the wind load requirements 

This should occur before the definition of the first load case:-  

  

 

Where:- 
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  - is the characteristic value of wind pressure, always positive. All values of the 
pressure within the range of corresponding SNiP table are valid. 

TERRAIN is terrain roughness category:-  

A – Costal Zone 

B – Urban  

C -  Large City according to the SNiP classification. 

CLASSIFICATION:  1 – for prismatic building structures,  

2 – for general concrete structures,  

3 – for general open framed steel structures. 

EXPOSURE: factors , multiplying wind pressure influence areas. For stick-
type structures with compact members aligned along the vertical line (e.g, 
chimneys, elevated water tanks), influence areas are set to unity, and exposure 
factors are aerodynamic diameters of members.  

 

b) Application of the wind load definition within a load case. 

Each load case which is to include a Russian wind load specification should include the 
following:- 

 

Where:- 

X, Z – define the wind direction. 

f  -  wind pressure factor; negative value is used to define a reverse wind direction 

OBLIQUE - defines wind to be applied at 45°. (note this parameter is only applicable for 
rectangular buildings. 

if – configuration  parameter for prismatic buildings, range 0-12; 
0 - prismatic building structure - Rectangular building- Outstanding architectural 

details on the left façade. 
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1 - prismatic building structure - Rectangular building- Both side façades are 
smooth 

2 - prismatic building structure - Rectangular building- Outstanding architectural 
details on the right façade 

3 - prismatic building structure - Rectangular building- Outstanding architectural 
details on both side façades 

4 - prismatic building structure - Rectangular building- Triangular building 
5 - prismatic building structure - Rectangular building- Rhombic building 
6 - prismatic building structure - Rectangular building- Number of vertices of 

polygonal building, not more than 12 
7 - prismatic building structure - Less than 3 — rectangular building 
8 - prismatic building structure - 3 — triangular 
9 - prismatic building structure - 4 — rhombic 
10 - prismatic building structure - More than 4 — polygonal 
11 - framed RC structure 
12 - lattice steel structure 

(note, it is ignored for non-building structures, but cannot be omitted from the command.) 

fNU – wind pressure correlation coefficient. If parameter is omitted or is exactly 1, a 
computed value is used instead. For rectangular buildings, the correlation 
coefficient is always calculated automatically, thus any specified value will be 
ignored. 

 

Additionally, as part of the load force is determined from the dynamic behavior of the 
model, the first load case that includes a Russian Wind Load specification also needs to 
include all the masses that can cause the structure to vibrate from which a dynamic 
analysis will be used to extract the mode shapes. 

Note that this in effect becomes a dynamic load case, thus if the effects of these forces are 
to be combined with the effects of static load cases, then this should be done using a 
LOAD COMBINATION which references the required load case results with the 
appropriate factors. 

 

c) Cut-Off Frequency or Mode Shape 

As the analysis will requires extraction of eigen solutions to determine the dynamic 
effects of the wind loading, the number of modes to be used will also affect the results.  
Thus setting the command CUT OFF FREQUENCY or CUT OFF MODE should be 
considered and specified as required prior to the definition of the load cases. 

If the cut-off command is omitted, six mode shapes are computed by default. 

For more information on these commands, see the Technical Reference manual section 5. 
30.1 Cut-Off  Frequency,  Mode  Shapes  or  Time. 
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Example 
 
DEFINE WIND LOAD 
TYPE 1 
SNIP PRESSURE 0.38 TERRAIN A CLASSIFICATION 1 
EXP 0.5 JOINT 1 3 5 7 9 11 
* 
LOAD 1 LOADTYPE WIND  TITLE Wind load in the +ve X direction 
WIND LOAD X 1  CONFIG 0 NU 1 TYPE 1  
* Mass model required in first wind load case 
JOINT LOAD 
3 TO 6 FZ 62.223 
9 TO 12 FZ 62.223 
* 
LOAD 2 LOADTYPE WIND  TITLE Wind load in the –ve X direction 
WIND LOAD X -1  CONFIG 0 NU 1 TYPE 1 
* No mass model or additional loads in this load case 
* 
LOAD 3 LOADTYPE WIND  TITLE Wind load in the +ve Z direction 
WIND LOAD Z 1  CONFIG 0 NU 1 TYPE 1 
* No mass model or additional loads in this load case 
* 
LOAD 4 LOADTYPE WIND  TITLE Wind load in the –ve Z direction 
WIND LOAD Z -1  CONFIG 0 NU 1 TYPE 1 
* No mass model or additional loads in this load case 
* 
LOAD 10 LOADTYPE DEAD TITLE Selfweight load case 
SELF Y -1 ALL 
* 
LOAD COMBINATION 100 Wind plus selfweight 
1 1.0 10 1.0 
 
 
 
Notes:- 
This command cannot be used with models that have been defined with the SET Z UP 
command. 
 
For more information on wind loading see sections 5.31.3 Definition of Wind Load and 
5.32.12 Generation of Loads of the Technical Reference Manual. 
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AD.V8i.2.3 Floor Response Spectrum 

Purpose  

The following commands have been added in order to allow the response spectrum of 
floors to be extracted from a time history analysis 

 

Description 
This command is used to specify the calculation of floor and/or joint spectra 
from time history results.   The Floor Response Spectrum command must 
immediately follow an analysis command.  That analysis can only contain a 
single time history load case. 

 

General Format: 

The format of the Floor Spectrum command is such that 3 sets of data are required thus:- 

1) Initiate command 

The command is initiated with the line:- 

GENERATE  FLOOR SPECTRUM 
 
 

2) Specify Floor Groups 

Next, identify the floors which will have spectrum curves generated either by 
referencing a NODE GROUP (see section 5.16) or explicitly listing the list of 
nodes that constitute the floor and the direction.  
 
 

      * GX 
BEGIN  FLOOR           DIRECTION GY {  TITLE  } 

     GZ 
 

joint_group 
                       
joint list        

 
 
Where:- 
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GX, GY and GZ specify up to 3 global directions for which acceleration vs 
frequency spectrums will be generated for this floor.   

Title – is an optional description of up to 50 characters, for this floor that will be 
displayed on the graphs in post processing. 

 
. 
 
The above can be repeated as many lines as necessary to specify all of the groups 
and directions that are needed. 
 
 

3) Specify Options 

Next enter additional parameters used in the Floor Spectrum calculations. 
 

 
FLOW f1  

   FHIGH f2  
OPTIONS                       ( FDELTA f3  ) 

DAMP f4  
RELATIVE   

 

 

This command may be continued over a number of lines by ending each line 
except the last with a hyphen. 

Required options: 

FLOW= Lowest frequency to be in the calculated spectrum.  FLOW should 
be greater than 0.01 Hz.  

FHIGH  = Highest frequency to be in the calculated spectrum. 

FDELTA = The spectrum will be calculated at FDELTA intervals from FLOW 
to FHIGH  

DAMP = Up to 10 damping values may be entered. One spectrum will be 
generated for each damping value for each global direction 
requested for each floor defined. The spectrum will be based on 
these modal damping ratios.  
3% damping should be entered as 0.03.  The default is 0.05. 

RELATIVE= If there is ground motion defined and you want the spectrums to be 
based on the relative acceleration of the floor to the ground 
acceleration, then include the RELATIVE parameter. 

 

Optional parameters.  
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THPRINT  =0, no print;    
=2, Print the time history acceleration being used in each spectrum 
calculation.  

SPRINT = Print the calculated spectrum. 

 

4) End the command 

Finally, the command is completed with the line:- 

 
END  FLOOR SPECTRUM 

 

A successful analysis will result in the output file containing the base shear in 
the global X, Y and Z directions. 

 
Example 
 
DEFINE TIME HISTORY 
TYPE 1 FORCE 
0 -20 0.5 100 1 200 1.5 500 2 800 2.5 500 3 70 16 0 
ARRIVAL TIME 
0 
DAMPING 0.075 
* 
LOAD 1 LOADTYPE SEISMIC  TITLE Time History Load case 
* Mass model required 
SELFWEIGHT X 1 
SELFWEIGHT Y 1 
SELFWEIGHT Z 1 
JOINT LOAD 
1 TO 6 FX 62.223 FY 62.223 FZ 62.223 
* Time loads 
TIME LOAD 
2 FX 1 1 
PERFORM ANALYSIS 
* 
GENERATE FLOOR SPECTRUM 
BEGIN FLOOR DIRECTION GX GZ Ground Motion 
_FL1 
_FL17 
BEGIN FLOOR DIRECTION GX GZ Floor 18 A/C unit 36 
_FL18 
OPTIONS FLO 0.5 FHI 35.0 FDEL 0.1- 
DAMP 0.03 0.05 0.07 – 
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RELATIVE 
END FLOOR SPECTRUM 
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AD.V8i.3  Features Affecting the Post-Processing 
(Results Mode) 
 

 
Several new features have been added and existing features have been modified in the 
post-processing section of the program, also known as the Results Mode. These are 
explained in the following pages. 
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AD.V8i.3.1 Time History Animation 

Purpose  
In order to visualize the displacement that occurs on a model during the application of a 
time history load, a new toolbar icon has been added which allows the displacement at a 
specific time instance to be displayed. 
 

Description 
The results toolbar has been updated to include a new option which is activated when the 
displacement diagram icon has been clicked and the current load case contains time 
history loading:- 
 

 
 
For a time history load case the displacement that is displayed will be defined by the time 
instance entered in the above edit box.  Alternatively the time can be set from a sliding 
scale by clicking on the button with the down arrow icon which displays the following 
option setting:-  

  
The slider scale is based on the overall time for which the time history analysis has been 
performed. 
The displacement is produced at the time at which the slider arrow is dragged to and the 
mouse button released.  
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If the ‘Apply Immediately’ option is selected, then the application will attempt to render 
the displacement diagram dynamically as the slider is dragged up and down the scale of 
time.  For large models this may prove to be too demanding on the graphics system and 
left un-checked which means that the displacement diagram will be produced at the time 
step at which the slider arrow is released. 
 
Note that the displacement diagram will be set to the scale as defined in the Scales sheet 
in the View>Structure Diagrams… dialog box.  
 
Additionally note that it is possible to view the time v displacement of individual nodes b 
clicking on the Dynamics>Time-Disp in the post processing mode which is only 
available for models that include time history. 
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AD.V8i.3.2 Enhanced Plate Stress Results 

Purpose  
In order to provide additional understanding of stress distribution in finite element 
models, STAAD.Pro has expanded the sets of results that can be reported for each 
element both in the Plate Centre Stress Table and graphically using the Plate Stress 
Contour. 
 

Description 
To view the results data of plate elements, enter the Post Processing (Results) Mode, and 
click on the Plate Contour Page on the left menu. 
 
Plate Centre Stress Table 
The new Combined Stresses sheet in the Plate Centre Stress table provides resolved 
stresses for the top (positive local Z) and bottom (negative local Z axis) surface for each 
plate element, referred to as the Top Combined Stresses and Bottom Combined Stresses 
respectively.   
 

 
Note that if the sheet title Combined Stresses is not visible on the top of the table, then 
click on the right arrows displayed on the left of the table header to scroll the table sheets 
which will display the title.  
 
The combined stresses are calculated thus:- 
 
Top 
 ܵܺ௧௢௣ ൌ ܵܺ ൅  ܵ/ܺܯ 
 ܵ ௧ܻ௢௣ ൌ ܻܵ ൅  ܵ/ܻܯ 
 ܵܺ ௧ܻ௢௣ ൌ  ܻܵܺ ൅  ܵ/ܻܺܯ
 
Bottom 
 ܵܺ௕௢௧௧௢௠ ൌ ܵܺ ൅  ܵ/ܺܯ 
 ܵ ௕ܻ௢௧௧௢௠ ൌ ܻܵ ൅  ܵ/ܻܯ 
 ܵܺ ௕ܻ௢௧௧௢௠ ൌ  ܻܵܺ െ  ܵ/ܻܺܯ
 
where 
 ܵ ൌ  ଶ/6 tݐ
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ݐ  ൌ  ݏݏ݄݁݊݇ܿ݅ݐ ݁ݐ݈ܽ݌ ݁݃ܽݎ݁ݒܽ
 
 
 
Plate Stress Contour 
 
The Plate Stress Contour sheet of the Diagrams dialog has been enhanced to allow 
visualization of these stresses.  The six new stress results are available in the Stress Type 
pull down menu thus:- 
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